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Introduction  
The "Amazing Animals" Curriculum Companion (CC) provides 18 different onscreen, 
computer-based activities about the basic characteristics of animals. It is designed to supplement 
a lesson on animals at the K-2 academic grade-level. Supports are provided for students to 
demonstrate understanding that all animals move, grow, and need food. Examples of different 
types of movement such as swimming, flying, and walking, along with differences in growth 
patterns and diet, will be explored.  
 
CC activities support goals in reading, writing, comprehension, and application of new concepts. 
Each activity offers different levels of support to the student while addressing the same content 
area. Additional print versions of the activities are also provided. This CC is designed to 
supplement your existing lesson plans, and should be accompanied by other literature, media, 
and class activities and discussion  

Targeted Learners 
This program is designed for students with K-2 grade-level academic goals. The activities are 
designed to be as age-neutral as possible, in an effort to appeal to older students for whom this 
academic level may be appropriate. The different levels of supports make each activity adaptable 
for students with a range of language, learning or physical access special needs.  

Academic Standards 
This CC is designed to support academic standards at the K-2 grade level. The Mid-continent 
Research for Education and Learning (McREL) Compendium of Standards and Benchmarks for 
K-12 Education, Georgia, Florida, Texas and California State Academic Standards documents 
were referenced during the creation of these activities. Access the complete list of targeted 
academic standards at www.mayer-johnson.com/CurriculumCompanions/StandardsAlignment  
Because standards differ from state to state, use the learning objectives as a guide to meeting 
your own curriculum goals and academic standards. You will find within this Implementation 
Guide ways to vary levels of support to accommodate a range of abilities and needs. In addition, 
you can make modifications to the target vocabulary as needed to better meet your students’ 
unique goals.  

Sample Learning Objectives 
1. Students will categorize animals by where they live. 
2. Students will identify how animals move. 
3. Students will compare how different animals move. 
4. Students will recognize that all animals eat food. 
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5. Students will identify that different animals eat different foods. 
6. Students will categorize animals by what they eat. 
7. Students will recognize that all animals grow. 

Target Vocabulary 
 

animal 
water 
land 
pets 
wild 

eat 
move 
walk 
swim 
fly 

air 
plants  
grow 
hunt

 
This list contains terms for basic and concrete ideas found within the unit, as well as terms for 
more abstract ideas or concepts. These more complex vocabulary words are included to 
provide specific students with a greater challenge. In order to meet the needs of your students, 
you may wish to delete certain words or simplify the associated descriptions and questions in 
the various activities

Important Usage Notes 

Software Compatibility 
This CC will run on v6.1.4 or higher of Boardmaker Plus!, Boardmaker with Speaking 
Dynamically Pro, or Boardmaker Plus Player for Macintosh and Windows. If you are running an 
older release of Boardmaker Plus v6, please visit www.mayer-johnson.com to download a free 
update. 

Boardmaker Plus Player 
If you are using this CC with the Boardmaker Plus Player, you will be able to use all existing 
activities as they are. You will be able to add new students, adjust student settings, and make 
minor adjustments to the content.  

► Note: You must be able to enter Design mode to fully customize the content, which 
requires a full version of Boardmaker Plus! or Boardmaker with Speaking Dynamically 
Pro. 

If you are running the program in a classroom with multiple computers and have one copy of 
Boardmaker Plus! or Boardmaker with Speaking Dynamically Pro, and have a Boardmaker Plus 
Player loaded on the other computers, you can make your changes on the computer with 
Boardmaker Plus! or Boardmaker with Speaking Dynamically Pro, and then copy the entire CC 
folder onto the other computers. 
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Design Mode 
You should NOT enter Design mode while using this CC, except where explicitly instructed to 
do so. While CC activities are Boardmaker boards that can be edited, many of the boards 
included in this CC use complex macros that can be disrupted if you enter Design mode.  

► Note: Do not alter the pages or buttons except where indicated. 

Modifying the Content 
Many of the CC activities allow you to change or add content. Onscreen steps will instruct you 
how to do this. Detailed, step-by-step instructions are also included in this Implementation Guide 
under the appropriate section for each activity. 

► Note: The content for certain activities cannot be easily modified by the teacher. These 
activities have a "This Activity Should Not Be Modified" warning on the Main Menu for 
each activity. 

Changes to the content are made through special administrator pages. In most cases, changing or 
adding content can be made in Use mode by following the onscreen instructions. However, 
certain activities will require that you enter Design mode and make changes. Onscreen directions 
will always be available when this is necessary.  
 
Changes to the content apply to all students. It is not possible to adjust the content presented to 
an individual student – only the level of support (as described in the Adjusting Level of Support 
for Different Students section). 
 
All administrator pages have one of three symbols to indicate whether you should enter Design 
mode: 

 
You must enter Design mode to change the content. You will need to modify text and 
pictures as instructed. 
 
You must enter Design mode to change the content. You should only modify the 
pictures on the buttons in order to customize your content.  
 
You should NOT enter Design mode on this page. Any changes can be made through 
Use mode. 
 

► Note: If you are using Boardmaker Plus Player software, you cannot enter Design mode. 
Entering Design mode requires a full version of Boardmaker Plus! or Boardmaker with 
Speaking Dynamically Pro software. 
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Setting Access Methods 
The default access method for using this CC is direct selection with a mouse or joystick. 
Alternate access methods include direct selection with a touch window or scanning with a 
switch. For additional information on alternate access methods, please refer to the Boardmaker 
Family of Software User’s Guide (or Boardmaker online help).  
 
The CCs support separate user accounts for each student. In order to save the access method as 
part of a specific user account, you must follow the instructions under the User Accounts 
section. 

Board Change Indicators 
If you see an arrow in a green box in the lower right corner of your buttons, you must turn off the 
Board Change Indicators. This feature can be distracting if it remains active. To turn off the 
Board Change Indicators, follow these steps:  
 

1. Press Ctrl + D to enter Design mode. 
2. Click on Board Change Indicators in the Dynamic Boards > Show submenu. 
3. Clear the Show Board Change Indicators check box in the Board Change Indicators 

dialog. 
4. Click on the OK button to close the Board Change Indicators dialog. 
5. Press Ctrl + U or select Use in the Dynamic Boards menu to return to Use mode. 

 
You will only need to complete these steps one time. Once you have turned off the Board 
Change Indicators, Boardmaker will remember this setting. 

Getting Started with the Curriculum Companion 

Overview 
Each CC is divided into four sections: Read, Write, Practice, and Quiz.  

 Read: New information is presented to the student.  

 Write: The student has the opportunity to work on written expression, expression 
through drawing, sentence building and spelling skills using various levels of support.  

 Practice: The student gets to practice knowledge and concepts from the Read section. 
Support and feedback are provided to the student.  

 Quiz: The student demonstrates their understanding through a variety of activities. Many 
of the Quiz activities overlap with the Practice activities, but no feedback is provided on 
correct/incorrect responses, and data is recorded.  

There is no strict order in which activities must be completed and it is not necessary for each 
student to complete all of the activities. You can choose which activities will be shown to each 
student (see Teacher Options for User Accounts). Choose the activities that best meet the needs 
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of  your curriculum. If a student does not already have some background knowledge of the topic 
through previous classroom lessons, it is strongly suggested that they begin with the Read 
section and additional supporting instruction.  
 

Adjusting Level of Support for Different Students  
In each CC, you can adjust the level of support to meet the needs of different students, while 
keeping the same content and learning objectives. Common supports that can be adjusted 
include: 

 Text-to-Speech auditory support 

 Level of auditory and visual feedback/prompting when incorrect answers are chosen 

 Number of choices presented at one time 

 Level of symbol support 

 Randomization of question order and answer locations 

These and other settings can be accessed through the Options button on the Main Menu for each 
activity. After logging in under a student's name, any changes you make to the activity settings 
will be saved under that student's account.  
 
The content presented in each activity can be adjusted to meet the needs of a specific classroom. 
See the Modifying the Content section for instructions on how to do this.  

► Note: Changes to the content will apply to all students. It is not possible to adjust the 
content presented to an individual student – only the level of support (as described 
above). 

User Accounts 
When you first launch the CC, you will see the Login screen. Click on the student's name, log in 
to their account and begin using the CC, or click on the Add Name button to add a new student. 
 
Each user account can have different access methods, auditory preview settings, and activity 
options settings. You can also show/hide activities for specific users.  
 

Teacher Options for User Accounts 
Click on the Teacher Options button to change the options for each user account. The default 
password is blank (just click on the Go button). After entering the password, the following 
options will appear: 

 Remove Name: Removes a student from the User List.  

 Edit Pictures: Edits the picture that will appear next to the student's name. Enter Design 
mode and place any picture into the box next to the student's name. 
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 Set Access Method: Use this to set the access method for a student account. Set the 
access method by following these steps: 

1. Click on the Set Access Method button. 
2. Click on the student's name that you wish to change. This will take you to the 

Set Access Method screen. 
3. Click on the Design Mode button. 
4. Set the access method through the Boardmaker Plus! menus (see the 

Boardmaker Family of Software User’s Guide or online help for more 
information on setting access methods). 

5. Press Ctrl + U to re-enter Use mode. 
6. Click on the Save & Return button. 

 Auditory Preview Setting: Turn the auditory preview on or off for a student's account. 
You can also set the volume of the preview. 

 Change Teacher Password: Change the password to access the Teacher Options. The 
default password is blank (just click on the Go button). 

 Hide/Show Activities: Choose which activities to present to a student. After clicking on 
this button, you will be prompted to click on a student's name. Clicking on a student's 
name will bring up a screen with all of the activities included in the CC. Activities that 
will be shown for that student have their titles shown in a red font, while the titles of 
hidden activities are shown in a gray font. To hide or show an activity for a student, 
simply click on the activity. 

When you are done making modifications, click on the Teacher Options button to hide the 
options. 

Curriculum Companion Activities 
Each CC activity is described in the following pages. For each activity, you will find a 
description of the activity and sample learning objectives, steps for student navigation, and 
options for adjusting the level of support and modifying content.  

Read Activities 
 Idea Map: A graphic organizer that presents the concepts covered in the unit in a visual 

diagram.  

 Topic Book: An interactive talking book that presents information related to the CC 
topic.  

 Glossary: A glossary of target vocabulary words for the unit, accompanied by 
illustrations or pictures.  

 Flash Cards: An electronic version of vocabulary flash cards, with descriptions and 
pictures for new vocabulary words. 

 Explore: A clickable visual scene or collection of pictures that students can explore. 
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Idea Map 

Description 

The Idea Map is a graphic organizer that presents the concepts covered in the unit in a visual 
diagram. Idea maps can be used as a pre-reading strategy to orient students to the information 
they will be learning about and to stimulate discussion that draws upon prior knowledge. It can 
also be used as a post-reading strategy to review concepts and information learned in the unit. 

Student Operation 

The Idea Map is meant primarily as a visual support. Students can also click on each picture in 
the map in order to hear more about that concept or fact. 

Topic Book 

Description 

This is an interactive talking book that presents information related to the CC topic. New 
concepts and facts will be introduced with illustrations and text. All text can be read aloud by the 
computer and supported to varying levels with symbol supports. 

Student Operation 

Click the Start Reading button to begin reading the book, or use the Table of Contents to jump 
to specific section. 
 
Each page of the book has a Navigation Bar at the bottom of the screen. The Navigation Bar will 
contain some or all of the following buttons: 
 

 
 
 

Read Page: Speaks the entire text of the page. 
 

 
 

Previous Page: Navigates to the previous page. 
 

 
 

Next Page: Navigates to the next page of the book. 
 

 
 

Re-read: Go back to the beginning of the book and read it again. 

 
 
 

 

Ask Me: The computer will ask a question, prompting the student to use a pre-
reading, during-reading, or post-reading strategy. These questions are intended to 
get the student thinking and to start discussion with facilitators/classmates. The 
computer does not require a response before continuing. 
 

 Target Words: Target vocabulary words are displayed in buttons on the right-
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hand side of page, along with picture supports. Clicking on the word will bring up 
the Glossary entry for that word. 

Options 

Each CC book contains a number of different options to let you customize the book to the needs 
of the individual student.  
 
To prevent students from changing the options, press the O key on your keyboard from the Main 
Menu for each activity. This will hide the Options button. Press O again to show the Options 
button. 
 

 Speech Mode: When this option is set to Recorded, the narration of the book will be read 
in recorded human speech. This may be more engaging and more easily understood by 
many students. When this option is set to Text-to-Speech, the narration of the book will 
be read by a computer text-to-speech voice.  

 Navigation: When this option is set to Regular, the student navigates the books by 
selecting the buttons from the Navigation Bar. When this option is set to Slideshow, the 
student can click anywhere on the page in order to advance to the next page. The 
Navigation Bar is hidden from view. This mode can be useful for a student who is still 
learning print concepts and board navigation. The student cannot navigate to a previous 
page or exit the book, although this is still possible through the keyboard shortcuts. 

 Navigation Options: This option has the following settings: 

o Next Page Only: In this mode, only the Next Page and the Read Page buttons will be 
shown. All other navigation buttons will be hidden. 

o Next & Previous: In this mode, the Next Page, Previous Page, and the Read Page 
buttons will be shown. The Stop button will be hidden. 

o All Controls: In this mode, the Next Page, Previous Page, and Stop buttons will all 
be shown. 

 Reading Strategy Prompts: The "Ask Me" button can be hidden by turning the Reading 
Strategy Prompts option off. You can turn this option off if you find your student getting 
too distracted by it. 

 Auto-Read Glossary Entries:  When this option is set to On, clicking on a New Word 
button will automatically read the word, description, and related words. When this option 
is set to Off, the student must click on each section of the New Word popup in order to 
hear the computer read it aloud. This is the same as the Auto-Read Setting available 
through the Glossary. 

 Symbol Support Options: CC books contain three levels of picture-symbol support for 
students with low or emerging literacy skills. The appropriate level should be chosen for 
each student: 

o No Symbol Support: Only text is shown. The student is able to read through 
decoding or sight-word recognition. 
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o Least Symbol Support: Text is shown with Mayer-Johnson PCS symbol-support for 
new vocabulary words only. 

o Most Symbol Support: Text is shown with Mayer-Johnson PCS symbol-support for 
most words on the page. 

 View Keyboard Shortcuts:  This button shows the keyboard shortcuts available in this 
activity.  They are as follows: 

o Right Arrow = Next Page 

o Left Arrow = Previous Page 

o Q   = Quit Book 

o S   = Speak (Read) Page 

o W   = New vocabulary word (if present) 

o ”=”   = Settings 

 

Modifying the Content 

The content for this activity cannot be easily modified by the teacher. If you wish to create your 
own adapted books, you may wish to download the Adapted Book Template, available through 
the AdaptedLearning.com website. 

Glossary 

Description 

The Glossary is a collection of target vocabulary words for the unit. All words are accompanied 
by illustrations or pictures, the description of the word, and related words or synonyms. This 
activity can be used on its own to review new target vocabulary words, and is also linked in the 
Book and Free Writing activities for students to refer back to.  
 
The Glossary also forms the basis for a number of other vocabulary activities throughout the rest 
of the CC, so if you are going to add content, it is a good idea to start with the Picture Dictionary. 

Student Operation 

When you first enter the Glossary, you are presented with the words accompanied by picture 
supports. Clicking on any word will bring up a Glossary entry with a larger illustration, a 
description of the word, and related words or synonyms. 

Options 

To access the Options screen, press the equals (=) key from the Glossary. 

 Auto-Read Setting: When this option is set to On, the word, description, and related 
words will automatically be read aloud by the computer. When this option is set to Off, 
the student must click on each section of the Glossary entry in order to hear the computer 
read it aloud.  
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Modifying the Content 

To change or add words to the Glossary, click on the Edit Vocabulary Words button from the 
Options screen. 
 
There are five easy steps to editing a Glossary entry: 
 
1. Edit Vocabulary List 
This is where you create the list of all the words that should be contained in the Glossary. 

 To add a word: Type in the word, then click on the Add Word button. 

 To delete a word: Click on the Delete button, then click on the word you want to delete. 

 To change the order of the words: Click on the Swap button, then click on the word 
you want to move, and the location you want to move it to. 

 
2. Edit Vocabulary Descriptions 
Click on the Edit Descriptions button to open the Edit Descriptions screen. This is where you 
will enter the descriptions for each word in your Glossary. Descriptions should explain what the 
word means and place it in a context that the student will understand. Examples can also be 
placed under descriptions. 

 To add a description: Click on the box beneath the word for which you want to enter a 
description. Then enter your description in the text entry box at the top of the screen. 
Click on the Update Description button when you are finished. 

 To edit a description: Click on the box beneath the word you want to edit. The current 
description will appear in the text entry box at the top of the screen. Use the backspace 
and arrow keys to edit the description. Click on the Update Description button when you 
are finished. 

 
3. Edit Synonyms/Related Words 
Click on the Edit Synonyms button to open the Edit Synonyms screen. This is where you will 
enter synonyms or words related to the target word. Synonyms and related words help a student 
place words in context and make connections to prior knowledge. 

 To add synonyms/related words: Click on the box beneath the word for which you 
want to enter synonyms/related words. Then enter all of your synonyms and related 
words in the text entry box at the top of the screen, separating each word with a comma. 
Click on the Update Description button when you are finished. 

 To change synonyms/related words: Click on the box beneath the word for which you 
want to enter synonyms/related words. Use the backspace and arrow keys to edit the 
description. Click on the Update Description button when you are finished. 

 
4. Edit Pictures 
Click on the Edit Pictures button to open the Edit Pictures screen. This is where you will choose 
the pictures, illustrations, or photos that will be associated with your target words.  
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When you enter a new word, Boardmaker will search its Symbol Library for a picture that 
matches that word. However, you can choose a different picture by following the steps below: 
 
To change the picture associated with a word:  

1. Press the Escape key to enter Design mode. 
2. Use the Boardmaker Symbol Finder to select a symbol from your Symbol Library and 

place it in the box below the word you want to change (or drag a picture you have saved 
on your computer or from any web page onto the box below the word you want to 
change). 

► Note: See your Boardmaker Family of Software User’s Guide (or Boardmaker online 
help) for more details on how to perform these steps. 

3. When you have finished making your changes, go to the File menu and select Save.  
4. Press Ctrl + U to return to Use mode. 

 
5. Load Pictures into Glossary 
When you have finished steps 1-4, you are ready to load your words into the Glossary. From the 
Edit Pictures screen, click on the Load Into Glossary button. The computer will go through 
each page of the Glossary and load in your words. This process may take a few minutes, 
depending on the speed of your computer. Do not enter Design mode during this process. When 
the computer asks if you want to save changes, click on the Yes button. 

Flashcards 

Description 

This activity is an electronic version of vocabulary flashcards. Descriptions and pictures for new 
vocabulary words are presented on one side of the card, and the words themselves are presented 
on the other side. Use this activity to review new vocabulary or to quiz students one-on-one or in 
a group. 

Student Operation 

The student is presented with a card containing either the description of a word or a picture of the 
word. When he/she clicks on the description/picture, a card with the correct word is shown 
above. The student is not required to enter response into the computer – they can respond 
verbally to a facilitator, or silently to themselves. When using this activity for a group, the 
teacher may wish to ask for verbal responses from the classroom. 
 
The Main Menu contains the following buttons: 

 Vocabulary Definitions Flashcards: The front side of the card will contain the 
description for a word. 

 Vocabulary Picture Flashcards: The front side of the card will contain a picture for the 
word. 
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 Read: In Read mode, both sides of the card will be shown at the same time. 

 Practice: In Practice mode, the front side of the flash card will be shown first, followed 
by the back side. 

To prevent students from changing the options, press the O key on your keyboard from the Main 
Menu. This will hide the Options button. Press O again to show the Options button. 

Options 

 Auto-Read Flashcards: When this option is set to On, the Flashcard will automatically 
be read aloud by the computer upon presentation. When this option is set to Off, the 
Flashcard will be presented silently. 

 AAC Device Mode: When this mode is set to On, the Flashcard can be "flipped" when 
the computer receives the correct word followed by the Enter key. This allows you to 
connect an AAC device to the computer, and have your student locate the correct word 
on their device in order to flip the card. You will have to configure a button on your 
device to send the Enter key. Please consult your device manual for more information on 
connecting your device to the computer. 

 Show Stop Button: This option will hide or show the Stop button when using the 
flashcards. Hiding the Stop button will prevent your student from exiting the activity 
before completing it. 

 Slideshow Mode: When this option is set to On, the student can click anywhere on the 
screen in order to "flip" the card. When this option is set to Off, the student must click on 
the card in order to "flip" it. 

 View Keyboard Shortcuts: This button shows the keyboard shortcuts available in this 
activity.  They are as follows: 

o Space Bar = Flip Card 

o Enter key = Enter word (under AAC Mode) 

o Q  = Exit Flashcards 

 

Modifying the Content 

In the Flashcard activity, you can add or delete words and edit your descriptions and pictures. To 
begin editing, press the equals key (=) from the Main Menu. 
 
Adding or modifying words is performed in the following steps: 
 
1. Edit Flash Card Words 
This is where you create the list of all the words that will be presented in the Flashcard activity. 

 To add a word: Type in the word, then click on the Add Word button. 

 To delete a word: Click on the Delete button, then click on the word you want to delete. 
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You can also import the words from your Glossary into your Flashcard activity. The Flashcard 
activity comes preloaded with the words from the Glossary. However, if you have made 
significant changes to the Glossary, you may wish to reload the words into your Flashcard 
activity. To load the words from the Glossary, click on the Get Words From Glossary button. 
 
When you have finished editing your word list, click on the Edit Prompts button. 
 
2. Edit Flashcard Prompts 
This is where you will edit the description that will be shown on the front side of the Flashcard. 
If you have loaded words from your Glossary, then the descriptions from the Glossary will be 
preloaded here. However, you may wish to edit the descriptions to remove explicit references to 
the target word, for example, changing "A bird is an animal that flies" to "This is an animal that 
flies.” 

 To add a prompt: Click on the box beneath the word for which you want to enter a 
prompt. Then enter your prompt in the text entry box at the top of the screen. Click on the 
Update Prompt button when you are finished. 

 To edit a prompt: Click on the box beneath the word you want to edit. The current 
prompt will appear in the text entry box at the top of the screen. Use the backspace and 
arrow keys to edit the prompt. Click on the Update Prompt button when you are 
finished. 

Click on the Check Pictures button when you are finished editing your prompts. 
 
3. Check Pictures 
This is where you will choose the pictures, illustrations, or photos that will be associated with 
your target words. If you have loaded words from the Glossary, the pictures from the Glossary 
will automatically be loaded here as well. 
 
When you enter a new word, Boardmaker will search its Symbol Library for a picture that 
matches that word. However, you can choose a different picture by following the steps below: 
 
To change the picture associated with a word:  

1. Press the Escape key to enter Design mode. 
2. Use the Boardmaker Symbol Finder to select a symbol from your Symbol Library and 

place it in the box below the word you want to change (or drag a picture you have saved 
on your computer or from any web page onto the box below the word you want to 
change). 

► Note: See your Boardmaker Family of Software User’s Guide (or Boardmaker online 
help) for more details on how to perform these steps. 

3. When you have finished making your changes, save your changes by going to the File 
menu and selecting Save.  

4. Press Ctrl + U to return to Use mode. 
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Reload Default Pictures: Clicking on the Reload Default Pictures button will load the pictures 
from the Glossary for any words contained in the Glossary, and will search the Symbol Library 
for a picture for any other words. 
 
When you are finished editing your pictures, click on the Back to Main button. You are now 
ready to use your flashcards. 

Explore 

Description 

In the Explore activity, students learn by exploring a visual scene or collection of pictures. 
Students can click on any picture in order to see and hear more information and view more 
photos or a multimedia presentation. This gives the student an opportunity to learn in a self-
directed manner with engaging material. 

Student Operation 

Students may click on any picture on the screen to hear and see more about that item. 

Options 

There are no user-adjustable options for this activity. 

Modifying the Content 

The content for this activity cannot be easily modified and should not be edited by the teacher. 

Write Activities 
 
Each of the following writing activities has a separate focus and goal, but all use a similar visual 
layout.  

 Errorless Writing: These activities guide the student through phrase choices to construct 
sentences. All choices are logical and relate to the content of the CC. In Sentence 
Building, the goal is to develop syntax skills using core words and target vocabulary.  

 Sentence Building: The student practices building simple two- or three-word sentences 
of the form Subject+Verb or Subject+Verb+Object/Descriptor. The student picks one 
word from each column in order to construct the sentence. In Structured Writing 
activities, the goal is for the student to strengthen sentence and word meaning by 
constructing sentences from the Word Banks. 

 Structured Writing: The student is given a Word Bank of 12, 20 or 32 words with 
optional picture supports. The Word Banks contain all the words needed to construct 
simple sentences. In Structured Writing activities, the goal is for the student to strengthen 
sentence and word meaning by constructing sentences from the Word Banks. 

 Free Writing: In Free Writing, the goal is for the student to express novel thoughts by 
combining letters to create new words and sentences, with the support of a keyboard and 
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targeted vocabulary for the lesson. Writers of all ages and ability levels should be given 
opportunities to access the Free Writing supports. Practice and experimentation with 
letter-by-letter writing can be an important part of literacy instruction. 

In addition to the activities above, the following activities focus on spelling and written and 
creative expression. 

 Fill-in-the-Blank: The student completes sentences by filling in blanks using Word 
Banks. 

 Word Scramble: The student practices spelling target words by unscrambling the letters 
to spell the word. 

 Draw a Picture: The student creates a picture by choosing a background and using a 
variety of stamps. 

Errorless Writing 

Description  

The Errorless Writing activities guide the student through phrase choices to construct sentences. 
All choices are logical and relate to the content of the CC. Students are given a starter phrase and 
choose from several finishing phrases, or choose from several starter phrases and then are given 
a finishing phrase. 
 
The goal in Errorless Writing is participation in the curriculum and modeling writing skills for 
the student. It provides the opportunity for a student to quickly produce written material with 
high success.  

Student Operation 

Each writing window is divided into the following sections: 

 Picture Display: A picture box at the top of the screen that shows an illustration or photo 
to support the writing.  

 Message Display: A display where all writing will be entered.  

 Word/Phrase Banks: A bank of words or phrases related to the topic. The student is 
either given one starter phrase and several finishing phrases, or several starter phrases and 
one finishing phrase. By default, the phrases cannot be selected out of order, ensuring 
that the student always constructs a grammatically correct sentence. When the student 
finishes a sentence, he/she can click on the Next Page button in order to go one to the 
next sentence. Sentences will be added on to each other as the activity progresses. 

On each page, the student or the teacher can click on the Choose Picture button in order to 
change the picture in order to offer a topic choice prior to beginning writing (e.g. "What do you 
want to write about?"), or after writing in order to select a picture that matches the sentence (e.g. 
"You wrote about the tiger. Let's find the picture of the tiger."). 
 
The right side of each page displays a toolbar containing the following buttons: 
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 Read Out Loud: Reads everything that has been written in the Message Display. 

 Print: Prints out a picture and the writing. 

 Clear All: Erases everything that has been written. 

 Hide Writing Grids: Hides the writing grids, showing only the picture and the Message 
Display containing what the student has written. This allows you to see more of the 
student's writing. 

Options 

To prevent students from changing the options, press the O key on your keyboard from the Main 
Menu. This will hide the Options button. Press O again to show the Options button. 
 

 Auditory Feedback: When this option is set to Read Words, the computer will read back 
each word or phrase immediately after it is selected. When this option is set to Read 
Sentences, the computer will read back each sentence after it is completed. 

 Writing Mode: When this option is set to Text-Only, only the words will be written into 
the Message Display above when the button is selected. Students using this mode should 
have some sight word recognition or ability to decode words. When this option is set to 
Pictures, words with picture-symbol supports will be placed into the Message Display 
when the button is selected. This mode is helpful for students who require picture-symbol 
supports in order to understand written text. 

 Fixed Order: When this option is set to On, the student cannot click on the phrases out 
of order, ensuring that a grammatically correct sentence will be constructed. When this 
option is set to Off, the student can click on the phrases in any order. 

 New Line at End of Sentence: When this option is set to On, each sentence will be 
placed on a separate line. This separates each sentence, making them easier to identify. 
Use this mode for students who are new to the concept of a sentence. When this option is 
set to Off, each sentence will be placed immediately after the one before it, constructing a 
paragraph. Use this mode for students who understand the concept of a sentence and to 
whom you want to introduce the concept of a paragraph. 

 Punctuation Mode: When this option is set to On, a separate "period" button will be 
required at the end of each sentence. When this option is set to Off, the period will 
automatically be entered at the end of the sentence. 

Modifying the Content 

The Word Banks for this activity cannot be easily modified and should not be edited by the 
teacher. 
 
The pictures can be easily modified. Keep in mind that the picture bank is shared among all the 
writing activities. 
 
To edit the pictures: 

1. In Use mode, click on the Choose Picture button from the main writing page. 
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2. Press the Escape key to enter Design mode. 
3. Replace the pictures on the buttons with any pictures you would like. 
4. Save your changes by going to the File menu and selecting Save. 
5. Press Ctrl + U to return to Use mode. 

Sentence Building 

Description 

In Sentence Building, the student practices building simple two- or three-word sentences, 
generally of the form Subject+Verb or Subject+Verb+Object/Descriptor. The student picks one 
word from each column in order to construct the sentence.  
 
In Structured Writing activities, the goal is for the student to strengthen sentence and word 
meaning by constructing sentences from the Word Banks. 

Student Operation 
Each writing window is divided into the following sections: 

 Picture Display: A picture box at the top of the screen that shows an illustration or photo 
to support the writing. 

 Message Display: A display where all writing will be entered.  

 Word Banks: The student is given one column of subject words, one column of verbs, 
and (optionally) a third column of object/descriptor words. The student selects one word 
from each column in order to construct a sentence. When the student has finished a 
sentence, he/she clicks on the Next Page button to go onto the next sentence. Sentences 
will be added on to each other as the activity progresses. 

On each page, the student or the teacher can click on the Choose Picture button in order to 
change the picture in order to offer a topic choice prior to beginning writing (e.g. "What you 
want to write about?"), or after writing in order to select a picture that matches the sentence (e.g. 
"You wrote about the tiger. Let's find the picture of the tiger."). 
 
On the right side of each page is a toolbar containing the following buttons: 

 Read Out Loud: Reads everything that has been written in the Message Display. 

 Print: Prints out a picture and the writing. 

 Clear All: Erases everything that has been written. 

 Hide Writing Grids: Hides the writing grids, showing only the picture and the Message 
Display containing what the student has written. This allows you to see more of the 
student's writing. 

Options 

To prevent students from changing the options, press the O key on your keyboard from the Main 
Menu. This will hide the Options button. Press O again to show the Options button. 
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 Difficulty: This option has two settings: 

o 2-Word Sentence Building: The student practices building simple two-word 
sentences of the form Subject + Verb. 

o 3-Word Sentence Building: The student practices building simple three-word 
sentences of the form Subject + Verb + Object/Descriptor. 

 Auditory Feedback:  When the Read Words option is highlighted, the computer will 
read back each word immediately after it is selected. When the Read Sentences option is 
highlighted, the computer will read back each sentence after it is completed. 

 Writing Mode: When this option is set to Text-Only, only the words will be written into 
the Message Display above when the button is selected. Students using this mode should 
have some sight word recognition or ability to decode words. When this option is set to 
Pictures, words with picture-symbol supports will be placed into the Message Display 
when the button is selected. This mode is helpful for students who require picture-symbol 
supports in order to understand written text. 

 Fixed Order: When this option is set to On, the student cannot click on the words out of 
order, ensuring that a grammatically correct sentence will be constructed. When this 
option is set to Off, the student can click on the words in any order. 

 New Line at End of Sentence: When this option is set to On, each sentence will be 
placed on a separate line. This separates each sentence, making them easier to identify. 
Use this mode for students who are new to the concept of a sentence. When this option is 
set to Off, each sentence will be placed immediately after the one before it, constructing a 
paragraph. Use this mode for students who understand the concept of a sentence and to 
whom you want to introduce the concept of a paragraph. 

 Punctuation Mode: When this option is set to On, a separate "period" button will be 
required at the end of each sentence. When this option is set to Off, the period will 
automatically be entered at the end of the sentence. 

Modifying the Content 

The content for this activity cannot be easily modified and should not be edited by the teacher. 

Structured Writing 

Description 

In the Structured Writing activities, the student is given a Word Bank of 12, 20 or 32 words with 
optional picture supports. The Word Banks contain all the words needed to construct simple 
sentences. The student constructs sentences by selecting words from the Word Banks.  
In Structured Writing activities, the goal is for the student to strengthen sentence and word 
meaning by constructing sentences from the Word Banks. 

Student Operation 

Each writing window is divided into the following sections: 
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 Picture Display: A picture box at the top of the screen that shows an illustration or photo 
to support the writing. 

 Message Display: A display where all writing will be entered.  

 Word Banks: The student is given a Word Bank of 12, 20, or 32 words with optional 
picture symbol supports for each word. The student can click on any word in the Word 
Bank in order to have it typed in the Message Display above. 

On each page, the student or the teacher can click on the Choose Picture button in order to 
change the picture in order to offer a topic choice prior to beginning writing (e.g. "What do you 
want to write about?"), or after writing in order to select a picture that matches the sentence (e.g. 
"You wrote about the tiger. Let's find the picture of the tiger."). 
 
The following buttons will appear at the bottom of the page: 

 Erase One Letter: Erases the last letter. This applies only if the Writing Mode is set to 
Text-Only (see below). 

 Erase One Word: Erases the last word. 

 Period/Punctuation: Types in a period or brings up the punctuation window, depending 
on settings. 

On the right side of each page is a toolbar containing the following buttons: 

 Read Out loud: Reads everything that has been written in the Message Display. 

 Print: Prints out a picture and the writing. 

 Clear All: Erases everything that has been written. 

 Hide Writing Grids: Hides the writing grids, showing only the picture and the Message 
Display containing what the student has written. This allows you to see more of the 
student's writing. 

Options 

To prevent students from changing the options, press the O key on your keyboard from the Main 
Menu. This will hide the Options button. Press O again to show the Options button. 

 Number of Words: This is the number of words that will be placed in the Word Bank. It 
can be set to 12, 20, or 32. 

 Word Bank Type: When this option is set to Words Only, only the text for the words 
will be shown in the Word Bank. When this option is set to Words w/Pictures, text and 
pictures for each word will be shown in the Word Bank. 

 Auditory Feedback:  When the Read Words option is highlighted, the computer will 
read back each word immediately after it is selected. When the Read Sentences option is 
highlighted, the computer will read back each sentence after it is completed. 

 Writing Mode: When this option is set to Text-Only, only the words will be written into 
the Message Display above when the button is selected. Students using this mode should 
have some sight word recognition or ability to decode words. When this option is set to 
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Pictures, words with picture-symbol supports will be placed into the Message Display 
when the button is selected. This mode is helpful for students who require picture-symbol 
supports in order to understand written text. When this mode is used, individual letters of 
the word cannot be edited. 

 New Line at End of Sentence: When this option is set to On, each sentence will be 
placed on a separate line. This separates each sentence, making them easier to identify. 
Use this mode for students who are new to the concept of a sentence. When this option is 
set to Off, each sentence will be placed immediately after the one before it, constructing a 
paragraph. Use this mode for students who understand the concept of a sentence and to 
whom you want to introduce the concept of a paragraph. 

 Punctuation Mode: When this option is set to Period, the Period/Punctuation button 
will immediately enter a "." when clicked. No other punctuation will be available. When 
this option is set to All Punctuation (Popup), clicking on the Period/Punctuation button 
will bring up a popup with the choices of different punctuation. 

Modifying the Content 

You can modify the words and pictures to correspond to your own lesson. 
 
To edit a word or picture: 

1. Go to the page you want to edit. 
2. Press the Escape key to enter Design mode. 

 If you are on a text-only page, select the Text Tool. 
 If you are on a page with picture symbol supports, select the Symbolate Tool. 

3. Click on a word to change it. 
4. Double-click on a picture to change it. 

► Note: Consult your Boardmaker Software Family User’s Guide (or Boardmaker online 
help) for more information on using the Symbolate Tool. 

5. Save your changes by going to the File menu and selecting Save. 
6. Select Ctrl + U to return to Use mode. 

 
To change the color: 
You can set the color of a word according to its classification (noun, verb, descriptor, 
preposition, or miscellaneous). 

1. Press the F1 key to enter the Edit Color Mode. 
2. Click on a button you want change. 
3. Click on one of the five word class buttons: noun, verbs, descriptor, preposition, or 

miscellaneous. This will color code the word according to the following color scheme: 
o Nouns: orange 
o Verbs: green 
o Descriptors: blue 
o Prepositions: pink 
o Miscellaneous: yellow 
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► Note: There is also a Grey-Out Button option. This makes the word dim and less likely to 
be selected. Greyed-out buttons can still be selected, but are visually de-emphasized.  

When you have finished changing the color, press the F1 key again to leave the Edit Color 
Mode. 

Free Writing 

Description 

In the Free Writing activities, the student is expected to type letter-by-letter using a keyboard or 
one of the built-in onscreen keyboards. Word banks for target vocabulary only are provided. 
 
In Free Writing, the goal is for the student to express novel thoughts by combining letters to 
create new words and sentences, with the support of a keyboard and targeted vocabulary for the 
lesson. Writers of all ages and ability levels should be given opportunities to access the Free 
Writing supports. Practice and experimentation with letter-by-letter writing can be an important 
part of literacy instruction. 

Student Operation 

Each writing window is divided into the following sections: 

 Picture Display: A picture box that shows an illustration or photo to support the writing 
project. 

 Message Display: A text display where all writing will be entered. Text can be typed in 
with a keyboard or words can be selected from the Word Banks. 

 Word Banks: A bank of words related to the topic that can be used to assist in writing. 
When you click on a word, it will be written into the Message Display. There are 
different types of Word Banks available (see the Options section below). 

 Bottom Tool Bar: The control bar at the bottom of the screen contains the following 
buttons: 

o Backspace One Character 

o Backspace One Word 

o Word Endings: Brings up a number of word endings choices, such as"-s,” "-'s,” and 
"-ly." This button can be turned off under the Options screen. 

o Conjugate: Brings up the different conjugated forms of the last word that was 
entered. This button can be used after any word, but obviously is only useful if used 
after a verb. This button can be turned off under the Options screen. 

o Review What You Learned: Shows a popup display with links back to the Concept 
Map, the Book, and the Glossary. This provides the student with an opportunity to 
review information they have seen previously in other sections of the CC. 

o Period/Punctuation: Will either enter a period, or bring up a choice of punctuation 
options, depending on the Punctuation Mode setting under the Options screen. 
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On the right side of each page is a toolbar containing the following buttons: 

 Read Out Loud: Reads everything that has been written in the Message Display. 

 Print: Prints out a picture and the writing. 

 Clear All: Erases everything that has been written. 

 Hide Writing Grids: Hides the writing grids, showing only the picture and the Message 
Display containing what the student has written. This allows you to see more of the 
student's writing. 

Options 

To prevent students from changing the options, press the O key on your keyboard from the Main 
Menu. This will hide the Options button. Press O again to show the Options button. 

 Word Bank: There are four different Word Bank options, each containing the same 
Word Bank vocabulary with target words only: 

o Keywords-Only: The word-bank contains text only. 

o Keywords w/Picture Symbols: The word-bank contains text with picture symbol 
supports. 

o Keywords w/ABC Keyboard: Text-only word-bank plus an onscreen keyboard in 
alphabetical layout. 

o Keyword w/QWERTY Keyboard: Text-only word-bank plus an onscreen keyboard 
in QWERTY layout. 

 Auditory Feedback: When this option is set to Read Words, the computer will read back 
each word or phrase immediately after it is selected. When this option is set to Read 
Sentences, the computer will read back each sentence after it is completed. 

 Punctuation Mode: When this option is set to Period Only, the period button will enter a 
"." into the Message Display. No other punctuation will be available. When this option is 
set to All Punctuation, clicking on the period button will bring up a popup with the 
choices of different punctuation. 

Modifying the Content 

You can modify the words and pictures to correspond to your own lesson. 
 
To edit a word or picture: 

1. Go to the page you want to edit. 
2. Press the Escape key to enter Design mode. 

o If you are on a text-only page, select the Text Tool. 
o If you are on a page with picture symbol supports, select the Symbolate Tool. 

3. Click on a word to change it. 
4. Double-click on a picture to change it. 

► Note: Consult your Boardmaker Software Family User’s Guide (or Boardmaker online 
help) for more information on using the Symbolate Tool. 
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5. Save your changes by going to the File menu and selecting Save. 
6. Press Ctrl + U to return to Use mode. 

 
To change the color: 
You can set the color of a word according to its classification (noun, verb, descriptor, 
preposition, or miscellaneous). 

1. Press the F1 key to enter the Edit Color Mode. 
2. Click on a button you want change. 
3. Click on one of the five word class buttons: noun, verbs, descriptor, preposition, or 

miscellaneous. This will color code the word according to the following color scheme: 
o Nouns: orange 
o Verbs: green 
o Descriptors: blue 
o Prepositions: pink 
o Miscellaneous: yellow 

► Note: There is also a Grey-Out Button option. This makes the word dim and less likely to 
be selected. Greyed-out buttons can still be selected, but are visually de-emphasized. 

4. When you have finished changing the color, press the F1 key to leave the Edit Color 
Mode. 

Fill-in-the-Blank 

Description 

In this activity, students are given sentences about the curriculum unit topic. Key words have 
been removed from the sentences and placed on the side of the screen. The student must place 
the word into the correct sentence. This activity works a number of different skills, including: 
comprehension of the basic facts and concepts from the unit; ability to identify the correct word 
from the context of the sentence; and the identification of target vocabulary words. 

Student Operation 

The keywords are shown on the left-hand side of the screen, while the sentences are shown on 
the right-hand side. 
 
There are two modes for selecting the words and placing them in a sentence:  

 Click-and-Drag Mode: The student drags the words using the mouse onto one of the 
sentence blanks;  

 Two-Click Mode: The student clicks on a word and then clicks on the blank to place it 
there.  

You can switch between these modes using the Options controls described below. 
 
There is also a Hear Sentence button to the left of each sentence, which will read the sentence 
aloud. 
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Students can complete the activity in Practice Mode or Quiz Mode. 

 Practice Mode: The student will be given immediate positive or negative feedback when 
selecting an answer. 

 Quiz Mode: The student's answers will be recorded and no feedback will be provided 
until the end of the quiz. 

When the student has finished, he/she should click on the Check Work button, which will show 
which answers he/she got correct. If he/she is in Practice Mode, he/she has the option to go back 
and correct the answers or to print a report.  

Options 

To prevent students from changing the options, press the O key on your keyboard from the Main 
Menu. This will hide the Options button. Press O again to show the Options button. 

 Level Of Prompting/Feedback: These refer to the degree of prompting and redirection 
that will be provided to the student when incorrect answers selected. These levels apply 
only in the Practice Mode. 

o High: This is the highest level of support. Words CANNOT be placed in an incorrect 
sentence. Positive feedback is provided after a correct response. 

o Medium: This is the middle level of support. Words CAN be placed in an incorrect 
sentence, but the student will be prompted to move the word to the correct sentence. 
Positive feedback is provided after a correct response. 

o Low: This is the lowest level of support. Labels can be placed in incorrect locations. 
No feedback is provided on an incorrect answer. A tone will be played after a correct 
answer. 

 Auditory Review: When this option is set to On, the entire sentence will be read aloud 
after a word is placed in a blank. When this option is set to Off, the sentence will not be 
read aloud after placing a word in the blank. 

 Number of Sentences on Screen: When this option is set to 5, only five sentences at a 
time will be displayed. When the student completes the first five sentences, he/she must 
click the Check Work button to check their answers and continue to the next five 
sentences. When this option is set to 10, all 10 sentences will be displayed on one screen. 

 Picture Supports (for target words only): When this option is set to On, the picture-
symbol will be shown above each target word. When this option is set to Off, only the 
word will be shown. 

 Selection Mode: When this option is set to Click-and-Drag, the student must click and-
drag each word onto the blank in the sentence using the mouse. When this option is set to 
Two-Click, the student first clicks on a word, then clicks on the blank where he/she wants 
the word to go. This mode requires less fine motor control and mouse skills than the 
click-and-drag mode. 
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 Choose Feedback Symbols: This button lets you choose from six different sets of 
symbols for "correct" and "incorrect." These symbols will be used to mark the answers 
incorrect or correct. 

Modifying the Content 

The content for this activity cannot be easily modified and should not be edited by the teacher. 

Word Scramble 

Description 

In this activity, the student will be shown a picture of a word and will be given the letters of the 
word out of order. The student will be asked to spell a word by selecting the mixed up letters in 
the correct order. This activity is a simple spelling game based on the target words for the unit. 

Student Operation 

The student is shown a picture of the word at the top of the screen, and is given the letters of the 
word in a random order below. A set of blank slots is shown above the letters, with one blank 
slot for each letter of the word. The student tries to spell the word by clicking on the letters in the 
correct order. When a letter is selected, it is automatically placed into the next available blank 
slot. Students can click on the Erase Letter button to remove the last letter from the blank slots. 
Students can also click on the Speak button to hear the letters they have selected thus far spoken 
as a word. 
 
Students can complete the activity in Practice Mode or Quiz Mode. 

 Practice Mode: The student will be given feedback when selecting the incorrect or 
correct answer. 

 Quiz Mode: The student's answers will be recorded and no feedback will be provided 
until the end of the quiz. 

Options 

To prevent students from changing the options, press the O key on your keyboard from the Main 
Menu. This will hide the Options button. Press O again to show the Options button. 
 

 Prompt/Feedback Level: These refer to the degree of prompting and redirection that 
will be provided to the student when incorrect answers selected. These levels apply only 
in the Practice Mode. 

o High: This is the highest level of support. Incorrect letters cannot be selected but will 
be rejected from the blank slots. The student may not continue until he/she has 
selected the correct letter. 

o Medium: This is the middle level of support. Incorrect letters can be selected and 
added to the blank slots. A buzzing sound will play when an incorrect letter is chosen, 
and the letter will be highlighted in red. The student must use the Erase Letter button 
to erase the letter. 
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o Low: This is the lowest level of support. Incorrect letters can be placed in the blank 
slots. A buzzing sound will play when an incorrect letter is chosen. There will be no 
visual feedback that the letter is incorrect. 

 Show Word: When this option is set to On, the correct spelling of the word will be 
shown immediately beneath the picture, providing the student with a model to follow. 
When this option is set to Off, only the picture will be shown. 

 Auto-Read Questions: When this option is set to On, the student will automatically be 
prompted verbally by the computer to "Spell the word _____." When this option is set to 
Off, no verbal prompt will be given. 

 Speak Each Letter: When this option is set to On, each letter will be spoken aloud when 
it is selected. When this option is set to Off, the letters will not be spoken aloud. 

 Word Order: When this option is set to In Order, the computer will present the words in 
the order that they are stored. When this option is set to Random, the computer will 
present the words in random order. 

 Letter Order: When this option is set to In Order, the letters of the word will not be 
scrambled. When this option is set to Random, the letters will be scrambled out of order. 

 Show Stop Button: This option will show or hide the Stop button on the questions 
pages. If the Stop button is hidden, the student must complete all the questions before 
exiting. 

 Choose Feedback Symbols: This button lets you choose from six different sets of 
symbols for "correct" and "incorrect.” These symbols will be used to mark the answers as 
incorrect or correct on the report page. 

Modifying the Content 

In this activity, you can add or delete words, or change the pictures associated with a word. 
 
To begin editing, press the equals key (=) to open the Word Scramble – Edit Word List screen. 
 
Adding or modifying words is performed in the following steps: 
 
1. Edit Words 
This is where you create the list of all the words that will be present in the Word Scramble 
activity. 

 To add a word: Type in the word, then click on the Add a Word button. 

 To delete a word: Click on the Delete button, then click on the word you want to delete. 

You can also import the words from your Dictionary into your Word Scramble activity. The 
Word Scramble activity comes preloaded with the words from the Dictionary. However, if you 
have made significant changes to the Dictionary, you may wish to reload the words into your 
Word Scramble activity. To load the words from the Dictionary, click on the Get Words from 
Glossary button. 
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When you have finished, click on the Edit Pictures button. 
 
2. Edit Pictures 
This is where you will choose the pictures, illustrations, or photos that will be associated with 
your target words. If you have loaded words from the Glossary, the pictures from the Glossary 
will be loaded here automatically. 
 
When you enter a new word, Boardmaker will search its Symbol Library for a picture that 
matches that word. However, you can choose a different picture by following the steps below: 
 
To change the picture associated with a word:  

1. Press the Escape key to enter Design mode. 
2. Use the Boardmaker Symbol Finder to select a symbol from your Symbol Library and 

place it in the box below the word you want to change (or drag a picture you have saved 
on your computer or from any web page onto the box below the word you want to 
change). 

► Note: Consult the Boardmaker Software Family User’s Guide (or Boardmaker online 
help) for more details on how to perform these steps. 

3. When you have finished making your changes, save your changes by going to the File 
menu and selecting Save.  

4. Press Ctrl + U to return to Use mode. 
 
When you are finished editing your pictures, click on the Choose Active Words button. 
 
3. Choose Active Words 
You can have up to 20 words stored in your Word Scramble activity. However, a maximum of 
10 of these words can actively be played at one time. 
 
Click on the words you want to be active. Active words are highlighted in red. To make a word 
inactive, click on it again. 
 
When you are finished, click on the Back to Main button. 

Draw a Picture 

Description 

In this activity, the student has an opportunity to draw pictures using stamps and backgrounds 
related to the CC topic. Students can choose from eight different backgrounds and up to 100 
different stamps. Pictures can be printed out when the activity is completed. 

Student Operation 

There are two selection modes available: click-and-drag mode and two-click mode.  
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 Click-and-Drag Mode: Students first click on the Choose a Background button in 
order to select from one of the eight background pictures. Students can then click on one 
of the ten images in the stamp library. Clicking on an image will bring up three different 
stamps sizes with that image. The student can then click-and-drag the stamp on to the 
background and release it wherever he/she would like to place the stamp. Clicking on the 
forwards or backwards arrows will scroll through the stamp library. To erase a picture, 
the student must drag the picture onto the trashcan (Delete) icon. 

 Two-Click Mode: Students first click on the Choose a Background button in order to 
select from one of the eight background pictures. Students then click on the Choose 
Stamp button, which brings up a selection of stamps. When a stamp is selected, three 
different stamps sizes will be shown. The student then selects the stamp size desired, then 
selects a location on the picture. The stamp will be placed at that location. To erase a 
picture, the student selects the trashcan (Delete) icon and then selects on the stamp to be 
deleted. 

When the student has finished drawing a picture, he/she must print it out in order to save it. 
Drawings cannot be saved on the computer, and exiting the activity will permanently erase the 
drawing from memory. 

Options 

To prevent students from changing the options, press the O key on your keyboard from the Main 
Menu. This will hide the Options button. Press O again to show the Options button. 
 

 Selection Mode: This option determines the way in which the student will select the 
stamps and place them on the picture. There are two choices: 

o Click-and-Drag: When this choice is active, students hold down the mouse button to 
drag the stamps on to the picture. This mode requires the ability to click-and-drag 
with a mouse. Touch screen users can also use this mode by switching the access 
method to Direct Touch. 

o Two-Click: When this choice is active, the student first clicks on the stamp, then 
clicks on a spot on the picture where he/she wants the stamp to be placed. Switch-
scanners must use this mode. 

Modifying the Content 

Teachers can put their images into the stamps and backgrounds of the Draw A Picture activity. In 
order to begin modifying the content, select the Options button from the Main Menu. This will 
bring you to the Options screen. 
 
To edit the Stamps: 

1. From the Options screen, click on the Edit Stamps button. This will take you to the Edit 
Stamps page. 

2. The computer will read instructions aloud and automatically enter Design mode. 
3. Place a picture into one of the 100 stamps buttons on this page by doing one of the 

following: 
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 Use the Boardmaker Symbol Finder to select a symbol from your Symbol Library 
and place it in the button, or 

 Drag a picture you have saved on your computer or from any web page onto the 
button. 

► Note: Consult the Boardmaker Software Family User’s Guide (or Boardmaker online 
help) for more details on how to perform these steps. 

4. Repeat this process to add as many stamps as you like. 
5. If you wish to replace a stamp, simply place your image onto the button containing the 

stamp you want to replace, and select Replace when you are asked if you want to add or 
replace. 

6. When you have finished adding or replacing stamps, save your changes by going to the 
File menu and selecting Save.  

7. Press Ctrl + U to return to Use mode. 
8. Click on the Return button. 
9. You will be prompted to click on the last button containing a stamp. Find and click on the 

last button that contains a picture, starting from the top-left and moving across and down. 
10. After clicking on the button, you will be brought automatically to the Draw A Picture 

page and your changes will be loaded. 
 
To edit the backgrounds: 

1. From the Options screen, click on the Edit Background button. This will take you to the 
Backgrounds page. 

2. The computer will read instructions aloud and automatically enter Design mode. 
3. Place a picture into one of the 10 background buttons on this page by doing one of the 

following: 
 Use the Boardmaker Symbol Finder to select a symbol from your Symbol Library 

and place it in the button, or 
 Drag a picture you have saved on your computer or from any web page onto the 

button. 

► Note: Consult the Boardmaker Software Family User’s Guide (or Boardmaker online 
help) for more details on how to perform these steps. 

4. If you wish to replace a background, simply place your image on to the button containing 
the background you want to replace, and select Replace when you are asked if you want 
to add or replace. 

5. When you have finished adding or replacing backgrounds, click on the File menu and 
select the Save option. 

6. Press Ctrl + U to return to Use mode. 
7. Click on any picture to return to the Options screen. 
8. Your new backgrounds will now be available in the Draw a Picture activity. 
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Practice/Quiz Activities 

Multiple Choice 

Description 

In the multiple choice activity, students will be asked a question relating to the CC topic and will 
choose from 2 to 4 possible answers. The questions will probe the student's recall of facts from 
the unit, understanding of key concepts from the unit, and application of these concepts. Each 
possible answer will be presented with text and picture supports. 

Student Operation 

The questions will be presented one at a time at the top of the screen. Two to four choices will be 
displayed across the bottom half of the screen. The student must click on a  choice. When he/she 
finishes, the report can be generated or the activity can be repeated. 
 
Students can complete the activity in Practice Mode or Quiz Mode. 

 Practice Mode: In Practice Mode, the student will be given multiple opportunities to 
select the correct answer, and will be given feedback when selecting the incorrect answer. 

 Quiz Mode: In Quiz Mode, the student's answers will be recorded and no feedback will 
be provided until the end of the quiz. 

Options 

To prevent students from changing the options, press the O key on your keyboard from the Main 
Menu. This will hide the Options button. Press O again to show the Options button. 

 Difficulty Level: This option sets the number of possible answers that the student will be 
presented with. You can to have the student choose from a field of 2, 3, or 4 answers. 

 Auditory Prompt/Feedback: When this option is set to On, when the student selects an 
incorrect answer, the computer will say "try again" and repeat the question when the 
student selects an incorrect answer (Practice Mode only). When this option is set to Off, 
the computer will not give a verbal response at an incorrect answer, but it will play a 
buzzing sound (Practice Mode only). 

 Visual Prompt/Feedback: When this option is set to On, and the student selects an 
incorrect answer, all the incorrect answers will be grayed out and the correct answer will 
be highlighted (Incorrect answers can still be selected). Additionally, the visual 
prompt/feedback will not take place until the second incorrect answer. When this option 
is set to Off, the visual prompt/feedback will occur after the first incorrect answer 
(Practice Mode only). 

 Auto-Read Questions: When this option is set to On, the questions will automatically be 
read aloud. When this option is set to Off, the questions will be shown on the screen but 
will not be automatically read aloud. The student can click on the question to hear it read 
aloud. 

Implementation Guide 35 
 



Curriculum Companion - Amazing Animals

 

 Max Errors: This is the number of incorrect answers the student can make before the 
computer moves on to the next question. If this option is set to Unlimited, the computer 
will not move on to the next question until the correct answer is selected. 

 Question Order: When this option is set to In Order, the computer will present the 
questions in the order that they are stored. When this option is set to Random, the 
computer will present the questions in random order. 

 Show Stop Button: This option will show or hide the Stop button on the Questions 
pages. If the Stop button is hidden, the student must complete all the questions before 
exiting. 

 Choose Feedback Symbols: This button lets you choose from six different sets of 
symbols for "correct" and "incorrect." These symbols will be used to mark the answers 
incorrect or correct on the report page. 

 View Keyboard Shortcuts: This button shows the keyboard shortcuts available in this 
activity.  They are as follows: 

o 1, 2, 3, 4 = Buttons 1, 2, 3, & 4 in Multiple Choice activities 

o S = Speak Question 

o Q = Exit Activity/Quit 

o G = Go (start activity from Main Menu) 

Modifying the Content 

In the multiple choice activity, you can add, delete, or modify questions. To begin editing the 
questions, press the equals key (=) key from the Main Menu. This will take you to the main Edit 
Questions page, which will show the first 5 questions that have been entered. 
 
You can have up to 10 questions stored. To see questions 6 to 10, click on the Question 6-10 
button. 
 
To add a question:  

1. Type in your question and click on the Enter Question button. 
2. Type in the correct answer and click on the Enter Question button. The computer will 

search the Symbol Library for a matching picture and will place it below the answer if it 
can find one. 

3. Type in the first foil (incorrect answer) and click on the Enter Foil #1 button. 
4. Type in the second foil (incorrect answer) and click on the Enter Foil #2 button. 
5. Type in the third foil (incorrect answer) and click on the Enter Foil #3 button. 
6. Type in the fourth foil (incorrect answer) and click on the Enter Foil #4 button. 
7. If Boardmaker was unable to find a picture for your answer or foil, or you wish to change 

the picture for your answer or foil, do the following: 
 Press the Escape key to enter Design mode. 
 Using the Boardmaker Symbol Finder or dragging a picture from a folder on your 

computer or from a web page, place your picture beneath the word. 
 Save your changes by going to the File menu and selecting Save. 
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 Press Ctrl + U to return to Use mode. 
8. Repeat the steps above to enter more questions. 
 

To edit a question: 
1. Click on the question, answer, or foil that you wish to change.  
2. Type in a revised or new question, answer, or foil and click on the Enter button. 

 
To delete a question: 

1. Click on the Delete Question button at the top of the screen. 
2. Click on the question you wish to delete. 

True and False Questions 

Description 

In the True-False activity, students will be asked a True or False question relating to the CC 
topic. The questions will probe the student's recall of facts from the unit, understanding of key 
concepts from the unit, and application of these concepts.  

Student Operation 

The questions will be presented one at a time at the top of the screen. The student selects the 
True or False button by clicking on it. When he/she finishes, a report can be generated or the 
activity can be repeated. 
 
Students can complete the activity in Practice Mode or Quiz Mode. 

 Practice Mode: The student will be given multiple opportunities to select the correct 
answer, and will be given feedback when selecting the incorrect answer. 

 Quiz Mode: The student's answers will be recorded and no feedback will be provided 
until the end of the quiz. 

Options 

To prevent students from changing the options, press the O key on your keyboard from the Main 
Menu. This will hide the Options button. Press O again to show the Options button. 

 Auditory Prompt/Feedback: When this option is set to On, and the student selects an 
incorrect answer, the computer will say the "try again,” and repeat the question. When 
this option is set to Off, and the student selects an incorrect answer, the computer will not 
give a verbal response. It will however play a buzzing sound (Practice Mode only). 

 Visual Prompt/Feedback: When this option is set to On, and the student selects an 
incorrect answer, all the incorrect answers will be grayed out and the correct answer will 
be highlighted (incorrect answers can still be selected). The visual prompt/feedback will 
not take place until the second incorrect answer. When this option is set to Off, the visual 
prompt/feedback will occur after the first incorrect answer (Practice Mode only). 

 Auto-read Questions: When this option is set to On, the questions will automatically be 
read aloud. When this option is set to Off, the questions will be shown on the screen but 
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will not be automatically read aloud. The student can click on the question to hear it read 
aloud. 

 Max Errors: This is the number of incorrect answers the student can make before the 
computer moves on to the next question. If it is set to Unlimited, the student must 
continue to try until the correct answer is chosen. 

 Question Order: When this option is set to In Order, the computer will present the 
questions in the order that they are stored. When this option is set to Random, the 
computer will present the questions in random order. 

 Show Stop Button: Turning this setting on or off will show or hide the Stop button on 
the questions pages. If the Stop button is hidden, the student must complete all the 
questions before exiting. 

 Choose Feedback Symbols: This button lets you choose from 6 different sets of symbols 
for "correct" and "incorrect.” These symbols will be used to mark the answers incorrect 
or correct on the report page. 

 View Keyboard Shortcuts: This button shows the keyboard shortcuts available in this 
activity.  They are as follows: 

o 1 = Yes 
o 2 = No 
o S = Speak Question 
o Q = Exit Activity/Quit 
o G = Go (start activity from Main Menu) 

Modifying the Content 

In the True-False Questions activity, you can add, delete, or modify statements. To begin editing 
the statements, press the equals (=) key from the Main Menu. This will take you to the main Edit 
Statements page, which will show the first 5 statements that have been entered. 
 
You can have up to 10 statements stored. To see statements 6 to 10, click on the Statements 6 
To 10 button. 
 
To add a statement:  

1. Type in your statement and click on the Enter a Statement button. 
2. Click on the True or False button to the right of your statement to indicate the correct 

answer. 
3. Repeat the steps above to enter more statements. 
4.  

To edit a statement: 
1. Click on the statement that you wish to change.  
2. Type in your new or revised statement and click the Enter A Question button. 

 
To delete a statement: 

1. Click on the Delete Statement button at the top of the screen. 
2. Click on the statement you wish to delete. 
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Yes-No Questions 

Description 

In the Yes-No activity, students will be asked a Yes or No question relating to the CC topic. The 
questions will probe the student's recall of facts from the unit, understanding of key concepts 
from the unit, and application of these concepts.  

Student Operation 

The questions will be presented one at a time at the top of the screen. The student selects the Yes 
or No button by clicking on it. When he/she finishes, a report can be generated or the activity can 
be repeated. 
 
Students can complete the activity in Practice Mode or Quiz Mode. 

 Practice Mode: The student will be given multiple opportunities to select the correct 
answer, and will be given feedback when selecting the incorrect answer. 

 Quiz Mode: The student's answers will be recorded and no feedback will be provided 
until the end of the quiz. 

Options 

To prevent students from changing the options, press the O key on your keyboard from the Main 
Menu. This will hide the Options button. Press O again to show the Options button. 

 Auditory Prompt/Feedback: When this option is set to On, and the student selects an 
incorrect answer, the computer will say "try again," and repeat the question. When this 
option is set to Off, and the student selects an incorrect answer, the computer will not give 
a verbal response. It will however play a buzzing sound (Practice Mode only). 

 Visual Prompt/Feedback: When this option is set to On, and the student selects an 
incorrect answer, all the incorrect answers will be grayed out and the correct answer will 
be highlighted (incorrect answers can still be selected). The visual prompt/feedback will 
not take place until the second incorrect answer. When this option is set to Off, the visual 
prompt/feedback will occur after the first incorrect answer (Practice Mode only). 

 Auto-Read Questions: When this option is set to On, the questions will automatically be 
read aloud. When this option is set to Off, the questions will be shown on the screen but 
will not be automatically read aloud. The student can click on the question to hear it read 
aloud. 

 Max Errors: This is the number of incorrect answers the student can make before the 
computer moves on to the next question. If it is set to Unlimited, the student must 
continue to try until the correct answer is chosen. 

 Question Order: When this option is set to In Order, the computer will present the 
questions in the order that they are stored. When this option is set to Random, the 
computer will present the questions in random order. 
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 Show Stop Button: Turning this option on or off will show or hide the Stop button on 
the questions pages. If the Stop button is hidden, the student must complete all the 
questions before exiting. 

 Yes-No Symbol Set: You can choose between two different sets of symbols for Yes and 
No.  

 Choose Feedback Symbols: This button lets you choose from 6 different sets of symbols 
for "correct" and "incorrect." These symbols will be used to mark the answers incorrect 
or correct on the report page. 

 View Keyboard Shortcuts: This button shows the keyboard shortcuts available in this 
activity.  They are as follows: 

o 1 = Yes 
o 2 = No 
o S = Speak Question 
o Q = Exit Activity/Quit 
o G = Go (start activity from Main Menu) 

Modifying the Content 

In the Yes-No Questions activity, you can add, delete, or modify questions. To begin editing the 
questions, press the equals (=) key from the Main Menu. This will take you to the main Edit 
Questions page, which will show the first 5 questions that have been entered. 
 
You can have up to 10 questions stored. To see questions 6 to 10, click on the Question 6-10 
button. 
 
To add a question:  

1. Type in your question and click on the Enter Question button. 
2. Click on the Yes or No button to the right of your question to indicate the correct answer. 
3. Repeat the steps above to enter more questions. 

 
To edit a question: 

1. Click on the question that you wish to change.  
2. Type in your new or revised question and click the Enter Question button. 

 
To delete a question: 

1. Click on the Delete Question button at the top of the screen. 
2. Click on the question you wish to delete. 

Sorting 

Description 

In this activity, the student is asked to take concepts learned from the unit and apply them by 
sorting or classifying a group of objects. The activity can be done either as the sorting activity, in 
which the student sorts the objects into different bins; or as a classifying activity, in which the 
student is given a category and asked to identify which object belongs in that category.  
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Student Operation 

There are two different formats you can choose for this activity: 

 All-at-Once: All of the objects are shown on the screen at one time, along with a bin for 
each one of up to 3 categories. The student must click-and-drag each object into a bin in 
order to sort them into the appropriate categories. 

 Field of 2, 3, or 4: Two, three, or four objects are shown at the bottom of the screen. The 
student is given a category and asked which object belongs in that category. The student 
clicks on an object to choose it. This mode requires less fine-motor control than the all-at-
once mode, and is also simpler cognitively and visually. 

The format can be selected from the Options screen (see below). 
 
Students can complete the activity in Practice Mode or Quiz Mode. 

 Practice Mode: The student will be given multiple opportunities to select the correct 
answer, and will be given feedback when selecting the incorrect answer. 

 Quiz Mode: The student's answers will be recorded and no feedback will be provided 
until the end of the quiz. 

Options 

To prevent students from changing the options, press the O key on your keyboard from the Main 
Menu. This will hide the Options button. Press O again to show the Options button. 
 

 Difficulty Level: The choices available for this option are: 

o Field of 2: Two objects are presented at the bottom of the screen. The student is 
given a category and asked which object belongs in that category.  

o Field of 3: Three objects are presented at the bottom of the screen. The student is 
given a category and asked which object belongs in that category. 

o Field of 4: Four objects are presented at the bottom of the screen. The student is 
given a category and asked which object belongs in that category. 

o All-at-Once: All of the objects are shown on the screen at one time, along with a bin 
for each one of up to 3 categories. The student must click-and-drag each object into a 
bin in order to sort them into the appropriate categories. 

 Auditory Prompt/Feedback: When this option is set to On, and the student selects an 
incorrect answer, the computer will provide verbal feedback and repeat the question 
(Practice Mode only). When this option is set to Off, when the student selects an incorrect 
answer, the computer will not give a verbal response. It will however play a buzzing 
sound (Practice Mode only). 

 Visual Prompt/Feedback: When this option is set to On, and the student selects an 
incorrect answer, all the incorrect answers will be grayed out and the correct answer will 
be highlighted. Incorrect answers can still be selected. The visual prompt/feedback will 
not take place until the second incorrect answer. When this option is set to Off, the visual 
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prompt/feedback will occur after the first incorrect answer. These settings apply only 
when the Difficulty Level is set to Field of 2, 3, or 4 and you are in Practice Mode. 

 Max Errors: This is the number of incorrect answers the student can make before the 
computer moves on to the next question. If it is set to Unlimited, the student must 
continue to try until the correct answer is chosen. These settings apply only when the 
Difficulty Level is set to Field of 2, 3, or 4 and you are in Practice Mode. 

 Question Order: When this option is set to In Order, the computer will present the 
questions in the order that they are stored. When this option is set to Random, the 
computer will present the questions in random order. 

 Auto-Read Questions: When this option is set to On, the questions will automatically be 
read aloud. When this option is set to Off, the questions will be shown on the screen but 
will not be automatically read aloud. The student can click on the question to hear it read 
aloud. 

 Edit Prompt/Feedback: Selecting the Edit button will take you to the screen where you 
can edit the prompt or question that is provided to the student at the beginning of the 
activity, and the feedback that is provided when a correct answer is chosen. 

 
To change the prompt or question: 

1. Type in your prompt or question. 
2. Click on the Update Question (Field of 2, 3, or 4) or the Update Question (all-

at-once) button. Since the two modes have different formats, the prompt or 
question can be different for each. 
 

To change the feedback:  
Feedback will always be provided in the format of <object> _____ <category>, i.e.  
<a dog> is <an animal>. You can change the phrase that goes between <object> and 
<category>. 
1. Type in your feedback phrase. 
2. Click on the Update Feedback button. 

 Show Groups: This setting applies only when the Difficulty Level is set to Field of 2, 3, 
or 4. When this option is set to On, the bin will be shown for each category at the top of 
the screen. When a correct answer is chosen, it will automatically be placed in the bin for 
the corresponding category. When this option is set to Off, the bins will not be shown. 

 Show Stop Button: Turning this setting on or off will show or hide the Stop button on 
the questions pages. If the Stop button is hidden, the student must complete all the 
questions before exiting. This setting applies only to the Difficulty Level is set to Field of 
2, 3, or 4. For the All-at-once difficulty students setting, use the Check Answers button to 
leave the activity. 

 Choose Feedback Symbols: This button lets you choose from six different sets of 
symbols for "correct" and "incorrect.” These symbols will be used to mark the answers as 
incorrect or correct on the report page. 
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 View Keyboard Shortcuts:  This button shows the keyboard shortcuts available in this 
activity.  They are as follows: 

o 1, 2, 3, 4 = Buttons 1, 2, 3, & 4 in Field of 2/3/4 levels 
o S  = Speak Question 
o Q  = Exit Activity/Quit 
o G  = Go (start activity from Main Menu) 

Modifying the Content 

You can add or delete words to a group, change the words or pictures, or change the groups. 
 
As you edit your group or object names, keep in mind that the auditory feedback after the correct 
answer will be in the form of <object> _________ <category>. You may wish to incorporate 
articles and choose appropriate plural or singular forms in order to make the feedback 
grammatically correct, e.g. <a dog> is <an animal>. 
 
To begin editing the groups, press the equals key (=) from the Main Menu. This will take you to 
the editing screens. For this activity, you must enter Design mode in order to edit the groups. 
Press the Click Here to Enter Design Mode and Edit the Buttons button to enter Design mode 
and begin editing. 
 
To add or replace an object in a group: 

1. Locate the picture for the object you want in your Symbol Finder, from a picture in a 
folder on your computer, or from a web page. 

2. Place the picture on one of the buttons in the group you want it to belong too. Make sure 
you fill the buttons starting from the top of each group – do not skip rows. If there is 
already an existing picture on this button, you will be asked if you want to add or replace. 
Select Replace. 

3. Edit the label beneath the picture and change it to an appropriate label for your object (if 
needed). If there is no label, use the Text Tool to add an appropriate label inside the 
button. Each picture must have the label. 

4. Repeat steps 1-3 for each object you want to add or replace. 
5. If you have any empty rows, make sure they are all at the bottom. If you have an empty 

row that is not at the bottom, move the pictures and labels "up" into the empty row so that 
only rows at the bottom are empty. 

6. When you are finished editing your groups, save your changes by going to the File menu 
and selecting Save.  

 
To delete an object: 

1. Click on the button for the object you wish to clear. Make sure that the button itself is 
selected, not the picture or the label on the button. 

2. Click on the Edit menu and select Clear. This will erase the picture and label from the 
button. (There are multiple ways to clear the picture label from the button – this is just 
one method.) 

3. If you have any empty rows, make sure they are all at the bottom. If you have an empty 
row that is not at the bottom, move the pictures and labels "up" into the empty row so that 
only rows at the bottom are empty. 
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4. When you are finished editing your groups, save your changes by going to the File menu 
and selecting Save.  

 
To add or modify a group: 

1. Using the Text Tool, enter a name in the top row (where it says "Enter names for your 
groups in this row"). If there is already an existing label, use the Text Tool to edit that 
label. Make sure there is only one label per group. 

2. Place the symbol or picture to represent the group in the box below the group, labeled 
"Place a picture/symbol to represent each group below:" You can place only one picture 
in this box. This picture does not require a label.  

3. Add objects to your group following the instructions above. 
4. If you have any empty rows, make sure they are all at the bottom. If you have an empty 

row that is not at the bottom, move the pictures and labels "up" into the empty row so that 
only rows at the bottom are empty. 

5. When you are finished editing your groups, save your changes by going to the File menu 
and selecting Save.  

 
When you are finished editing your groups, save your changes by going to the File menu and 
selecting Save. Then return to Use mode by pressing Ctrl + U, and click on the Load Pictures 
button to load the pictures into all of the activities. 

Matching Word-to-Pictures 

Description 

In this activity, students are asked to match target words to their corresponding pictures. This 
helps build vocabulary comprehension and word recognition. 

Student Operation 

The Matching Words-to-Pictures activity has distinct modes in which it can be played: 

 All-at-Once: All of the words and their corresponding pictures are shown on the screen 
at one time. The student must click-and-drag each word to its corresponding picture. 

 Field of 2, 3, or 4: One word is presented at the top of the screen, and two, three, or four 
pictures are shown below. The student chooses which picture below goes with the word 
by clicking on the picture. This mode requires less fine-motor control than the all-at-once 
mode, and is also simpler cognitively and visually. 

Students can complete the activity in Practice Mode or Quiz Mode. 

 Practice Mode: The student will be given multiple opportunities to select the correct 
answer, and will be given feedback when selecting the incorrect answer. 

 Quiz Mode: The student's answers will be recorded and no feedback will be provided 
until the end of the quiz. 
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Options 

To prevent students from changing the options, press the O key on your keyboard from the Main 
Menu. This will hide the Options button. Press O again to show the Options button. 
 

 Difficulty Level: This option has the following choices: 

o Field of 2: One word is presented at the top of the screen, and two pictures are 
presented at the bottom. The student is asked which picture goes with the word above. 

o Field of 3: One word is presented at the top of the screen, and three pictures are 
presented at the bottom. The student is asked which picture goes with the word above. 

o Field of 4: One word is presented at the top of the screen, and four pictures are 
presented at the bottom. The student is asked which picture goes with the word above. 

o All-at-Once: All of the words and pictures are shown on the screen at one time. The 
student must click-and-drag each word to the picture it goes with it. 

 Picture Cue: When this option is set to On, a picture of the word will be placed next to 
the word that is presented, and the student will be asked to find the matching picture 
below.  When this option is set to Off, only the word will be shown. This setting applied 
only when the Difficulty Level is set to Field of 2, 3, or 4. 

 Auditory Prompt/Feedback: When this option is set to On, and the student selects an 
incorrect answer, the computer will provide verbal feedback and prompt the student to 
find the correct picture. When this option is set to Off, and the student selects an incorrect 
answer, the computer will not give a verbal response. It will however play a buzzing 
sound (Practice Mode only). 

 Visual Prompt/Feedback: When this option is set to On, and the student selects an 
incorrect answer, all the incorrect answers will be grayed out and the correct answer will 
be highlighted (incorrect answers can still be selected). The visual prompt/feedback will 
not take place until the second incorrect answer. When this option is set to Off, the visual 
prompt/feedback will occur after the first incorrect answer.  

► Note: The feedback settings apply only when the Difficulty Level is set to Field of 2, 3, 
or 4 and you are in Practice Mode. 

 Max Errors: This is the number of incorrect answers the student can make before the 
computer moves on to the next question. If it is set to Unlimited, the student must 
continue to try until the correct answer is chosen. These settings apply only when the 
Difficulty Level is set to Field of 2, 3, or 4 and you are in Practice Mode. 

 Show Stop Button: Turning this setting on or off will show or hide the Stop button on 
the questions pages. If the Stop button is hidden, the student must complete all the 
questions before exiting. 

 View Keyboard Shortcuts: This button shows the keyboard shortcuts available in this 
activity.  They are as follows: 

o 1, 2, 3, 4 = Buttons 1, 2, 3, & 4 in Field of 2/3/4 levels 
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o S = Speak Question 
o Q = Exit Activity/Quit 
o G = Go (start activity from Main Menu) 
o C = Check work (All-at-once option only) 

 Choose Feedback Symbols: This button lets you choose from 6 different sets of symbols 
for "correct" and "incorrect." These symbols will be used to mark the answers as 
incorrect or correct on the report page. 

Modifying the Content 

In this activity, you can add or delete words, or change the pictures associated with a word. 
 
To begin editing, press the equals key (=) from the Main Menu. This will bring you to the editing 
screen. 
 
Adding or modifying words is performed in the following steps: 
 
1. Edit Matching Words 
This is where you create the list of all the words that will be present in the Matching Word-to-
Picture activity. 

 To add a word: Type in the word, then click on the Add a Word button. 

 To delete a word: Click on the Delete button, then click on the word you want to delete. 

You can also import the words from your Dictionary into your Matching Word-to-Picture 
activity. The Matching Word-to-Picture activity comes preloaded with the words from the 
Dictionary. However, if you have made significant changes to the Dictionary, you may wish to 
reload the words into your Matching Word-to-Picture activity. To load the words from the 
Dictionary, click on the Get Words from Dictionary button. 
 
When you have finished, click on the Edit Pictures button. 
 
2. Edit Pictures 
This is where you will choose the pictures, illustrations, or photos that will be associated with 
your target words. If you have loaded words from the Dictionary, the pictures from the 
Dictionary will be loaded here automatically. 
 
When you enter a new word, Boardmaker will search its Symbol Library for a picture that 
matches that word. However, you can choose a different picture by following the steps below: 
 
To change the picture associated with a Word:  

1. Press the Escape key to enter Design mode. 
2. Use the Boardmaker Symbol Finder to select a symbol from your Symbol Library and 

place it in the box below the word you want to change (or drag a picture you have saved 
on your computer or from any web page onto the box below the word you want to 
change). 
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► Note: Consult your Boardmaker Software Family User’s Guide (or Boardmaker online 
help) for more details on how to perform these steps. 

3. When you have finished making your changes, save your changes by going to the File 
menu and selecting Save.  

4. Press Ctrl + U to return to Use mode. 
 
When you are finished editing your pictures, click on the Load Pictures button. This will load 
the pictures into each page of the activity. This may take a minute, depending on the speed of 
your computer. Do not interrupt this process or enter Design mode.  
 
When it is finished loading, the "Finished Loading Pictures" message will appear. 
 
3. Choose Active Words 
You can have up to 20 words stored in your Matching Words-to-Pictures activity. However, a 
maximum of 10 of these words can actively be played at one time. 
 
Click on the words you want to be active. Active words are highlighted in green. To make a 
word inactive, click on it again. 
 
When you are finished, click on the Return button. 

Word Search 

Description 

This activity is the classic "word search,” in which the student must find words hidden within a 
grid of letters. Target words from the unit are placed within a 10x8 grid of letters. The student 
must find all of the words in order to complete the activity. This activity works on word 
identification and visual discrimination. 

Student Operation 

The student must locate each word listed in the word list in the 10x8 grid of letters. Words can be 
placed horizontally left-to-right or vertically top-to-bottom. The student can select a word by 
clicking on any letter in the word. If the letter belongs to more than one word, both words will be 
selected. Words that have been found will be highlighted and cannot be clicked again. When all 
the words have been found, the game is over. 

Options 

There are no teacher-selectable options for this activity.  

Modifying the Content 

The content for this activity cannot be easily modified and should not be edited by the teacher. 
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